LABORATORY TWO
Masking and Spectral Thresholds
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Purpose-

This exercise will attempt to accomplish the following goals:

e Spectral threshold

e (Classification (water mask)

e Use of vectors for image clipping

Laboratory introduction-

In this exercise, you will begin by importing a vendor provided data file with projection information. You

will use a polygon vector file to clip the imagery and classify using a simple threshold. You will then create

a rudimentary analysis of the extent of water bodies in each area. There are many methods of image

classification from simple thresholding to mor

e complex segmenatation with the assistance of machine

learning (ML). This laboratory you will skip the “wizards” tools and dig into the spectral data or called

feature space, of what the color coordinates are for each of the pixels in the image.
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Exercise 1 (Locate vector and raster data sets)
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Feel free to coordinate with other course participants to
select different dates and seasons. For this laboratory you
are required to use Landsat 8 Collect 2 Level 1 data. These
data are presented in the WRS path/row reference
system. There is also the If you are using Landsat ARD tiles,

visit the Landsat ARD tile conversion tool to determine
which ARD tiles cover your area of interest or which WRS
path and row the ARD horizontal (h) and vertical (v) tile
index it covers. In addition to imagery, locate a vector file
that contains a polygon vector of Lafayette County,
Mississippi. Suggest you use a national boundary dataset
(NBD). Best URL is: https://nationalmap.gov/



https://landsat.usgs.gov/ard_tile
https://nationalmap.gov/
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Select the USGS National Boundary Dataset (NBD) in Mississippi

<< Previous

<< Previous

1 through 2 of 2 results
1

USGS Mational Boundary Dataset (NBD) in Arkansas 20211122
State or Territory FileGDB 10.1
Published Date: 2021-11-22
Metadata Updated: 2017-10-25
Format: FileGDE 10.1
Extent; Stak

USGS Mational Boundary Dataset (WBD) in Mississippi 20211122
State OF TeTTTror bR
Published Date: 2021-11-22

fadata Upd 7-10-25

—r o

Copyright © 2021 University of Mississippi
All Rights Reserved.

Next ==

Footprint
Thumbnail

Zoom To
Info/Metadata
Vendar Metadata
Download Link (ZIP)

otprint
Thumbnail
Zoom To
Info/Metadata
Vendor Metadata

Download Link (ZIP)

Mext ==



Opening GOVTUNIT_Mississippi_State_GDEB.zip *

You have chosen to open:
@ GOVTUNIT_Mississippi_State_GDB.zip

which is: zip Archive (18.9 MB)
from: https://prd-tnm.s3.amazonaws.com

What should Firefox do with this file?
ngen with | 7-Zip File Manager (default) ~

©§§ave File

[] Do this automatically for files like this from now on.

Cancel

You will use this data to clip the imagery. A good practice is to create your own database

For the raster, select the Landsat 8 OLI Collection 2 Level 1 product. The DN values in C2L1 are in the units

of scaled radiance and can be converted to Top of Atmosphere (TOA) reflectance or radiance using the

radiometric scaling factors provided in each scene metadata file

Li—J"Landsat Collection 2 Level-1

EI@ &8 Landsat 8 OLUTIRS C2 L1
5---1]@ &8, Landsat7 ETM+ C2L1

" @E @ Landsat4-5TM C2 L1
5---1:]@ & Landsat 1-5 M55 C2 L1

| andsat C2 Atmospheric Auxiliary Data [J
ElLandsat Collection 1

E-Landsat Collection 1 Level-3
é"Landsatﬁ U.5. Analysis Ready Data (ARD)
“[] @ E &8 Landsat4-8U S ARD
é|"Lar||LIsat Collection 1 Level-2 (On-demand)
-] @ [E &8 Landsat 8 OLITIRS C1 Level-2
0@ 4 Landsat7 ETM+ C1 Level-2
EI @ [E & Landsat 4-5 TM C1 Level-2
E-Landsat Collection 1 Level-1
D@ & Landsat 8 OLITIRS C1 Level-1
|:| @ =] #p Landsat 7 ETW+ C1 Level-1

=[] @ (& # Landsat 4-5 TM C1 Level-1

3. Additional Criteria (Optional)

If you have more than one data sets selected, use the
dropdown to select the additional criteria for each data set.

Dala Sets: )
| Landsat 8 OLUTIRS C2 L1 ~ |
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https://www.usgs.gov/centers/eros/science/usgs-eros-archive-landsat-archives-landsat-8-9-operational-land-imager-and
https://www.usgs.gov/landsat-missions/landsat-collection-2-level-1-data
https://www.usgs.gov/landsat-missions/landsat-collection-2-level-1-data
https://www.usgs.gov/landsat-missions/using-usgs-landsat-level-1-data-product
https://www.usgs.gov/landsat-missions/using-usgs-landsat-level-1-data-product

Land Cloud Cover O]
0 to 10 =

From the results, select an appropriate image. In the following example, we select a 22 Nov 2021 image

of Path/Row (22/36).

Product Options - Landsat Collection 2 Level-1 Product Bundle

Download Full-Resolution Browse (Natural Color) GeoTIFF {1400 MIiB)
Download Full-Resolution Browse (Thermal) GeoTIFF (14.00 MiB)
Download Full-Resolution Browse (Quality) GeoTIFF {(14.00 MiB)
Download Full-Resolution Browse (Matural Color) JPEG (6.00 MIiB)
I GEGES  Full-Resolution Browse (Thermal) JPEG (6.00 MiB)

Download Full-Resolution Browse (Quality) JPEG (6.00 MIB)

Select the product options

Copyright © 2021 University of Mississippi 4
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Product Download Options for LC08_L1TP_022036_20211122_20211130_02_T1 ®

Landsat Collection 2 Level-1 Product Bundle

E A RIReTEM Landsat Collection 2 Level-1 Product Bundle

The following items are available for individual download

(Item Name Filter)
PHI Lcos L1TP_022036_20211122_20211130_02_T1_ANG.txt
E Al | -ndsat Coilection 2 Level-1 Band File
PUTPNITT) L0 L1TP_022036 20211122 20211130_02_T1_B10.TIF
. Landsat Collection 2 Level-1 Band File
PP Lco8_L1TP_022036_20211122_20211130_02_T1_B11.TIF
= Landsat Collection 2 Level-1 Band File
. LCO08_L1TP_022036_20211122_20211130_02_T1_B1.TIF
E ARl | andsat Goilection 2 Level-1 Band File
PUZTTIYT LC08 L1TP_022038_20211122_20211130_02_T1_B2.TIF
— Landsat Collection 2 Level-1 Band File
. LCO08 L1TP_022036_20211122_20211130_02_T1_B3.TIF
-E * 80.47 MiB I andsat Collartinn 21 eusl. 4 Band Eile - - - st

It is best practice to download the Collect 2 Level-1 product bundle. It is large and includes ALL the

bands and metadata for the acquired Landsat scene. You can be more selective and only download the

bands you need for your analysis. If you do not want the panchromatic band, you can save more 300 MB

and only download everything else.

You have chosen to open:
LCO8_L1TP_022036_20211122_20211130_02_T1.tar

which is: tar Archive (1.1 GB)
from: https://landsatlook.usgs.gov

What should Firefox do with this file?
(C) Open with | 7-Zip File Manager (default) w
(® Save File

oK Cancel

Once again, this is a tar compressed file so be sure to use a compression utility to properly decompress
these types of files. Note in the above image, the 7-Zip file manager recognizes this to be a tar file. Save

the file in a temporary location before you decompress it.

Copyright © 2021 University of Mississippi
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If you are using Landsat ARD tiles, visit the Landsat ARD tile conversion tool to determine which ARD

tiles cover your area of interest or which WRS path and row the ARD horizontal (h) and vertical (v) tile

index it covers.

Landsat ARD Tile Conversion Tool

The Landsat Analysis Ready Data (ARD) Tile Conversion Tool converts latitude/longitude coordinates or a single Landsat WRS-2 path/row into the corresponding Landsat ARD tiles, displays them on the map, and lists them all on the right side
of the map.

U.S. Landsat ARD is available for the conterminous United States (CONUS), Alaska, and Hawail, for Landsat Collection 1 and Landsat Collection 2. NOTE: The tiles for CONUS and Hawaii are the same for Landsat Collection 1 and Landsat
Collection 2. For Alaska, additional files were added to the Collection 2 grid. Select Collection 2 to view the new Alaska tiles.

Legena: ll wrs2 [l ArDTie ® Laviong Point
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s Kn @ Cenvert from WRS-2 Path/Row to ARD Tile
W o . .
N 121 TENNESSEE
V12 7 2 h:22 n
= 4. O Cenvert from Latitude/Longitude te ARD Tile and WRS-2 Path/Row
Memphre e Chatonsons ¥ Latitude: |34.550049¢ + is North, - is South
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uschita Littls Rock Hurt il Chatan .
Zhon o Holl & : [+ -
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Extract your Landsat 8 data by selecting the tar file then right-mouse button to bring up the context menu.

Next select the 7-Zip or similar compression tool and decompress the file.

LCC.'!S:L‘""_“""""“_“"““"‘_"""‘“1 = 1rHnan nEE B tar Archive 1
Open
@ Move to OneDrive >
7-Zip > Open archive
CRC SHA > Open archive >
u Edit with Motepad++ Extract files...
Ea Scan with Microsoft Defender... Extract Here
|2 Share Extract to "LC0O8_L1TP_022036_20211122_20211130_02_T1\"
Open with... Test archive
™ Scan with Malwarebytes Add to archive...
Restore previous versions Compress and email...
Send to > Add to "LC08_L1TP_022036_20211122_20211130_02_T1_2.7z"
Compress to "LC08_L1TP_022036_20211122_20211130_02_T1_2.7z" and email
cut Add to "LC08_L1TP_022036_20211122_20211130_02_T1_2.zip"
Copy Compress to "LC08_L1TP_022036_20211122_20211130_02_T1_2.zip" and email
Create shortcut
Delete
Rename
Properties

Do the same for the boundary file you downloaded from the National Map.

Copyright © 2021 University of Mississippi 6
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https://landsat.usgs.gov/ard_tile

Create a New Project e

Name Lafayette_County

Location | CA\Users\yourname\Documents\ArcGl5\lafayette_water

Create a new folder for this project

Cancel

After the project is created, connect the imagery directory and where you save the vector data or the

National Boundary Database (NBD).

& Lafayette County
211
4 MED
4 GOVTUNIT_Mississippi_State_GDB
4 3 GOVTUNIT_Mississippi_State_GDB.gdb
4 [ GovernmentUnits
| GU_CountyOrEquivalent
GU_IncorporatedPlace
GU_lurisdictional
GU_MinorCivilDivision
GU_MativeAmericanfrea
GU_PLSSFirstDivision
GU_PLSSSpecialSurvey
GU_PLSSTownship
GU_Reserve
GU_StateOrTerritory
GU_UnincorporatedPlace
EPFeatureToMetadata
Meta_DatasetDetail
Meta_ProcessDetail
b Bl GOVTUNIT Mississippi_State GDB jpg
GOVTUNIT_Mississippi_State_GDBxml

You can copy the GU_CountyOrEquivalent feature class from the GOVUNIT_Mississippi_State_GDB

database you download

Copyright © 2021 University of Mississippi 7
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4 5| Databases

7 Lafayette County
bl Styles
. B Add To Favorites
= Folders
Add To Mew Project:
b g Lafayette County o e TTeEeE
P 2Ll New "
4 MNED Import 4
4 GOVTUNIT_M Export 4
4 & GOVTUNIT
Manage L4
4 E' Gowvern
f& Domains
Gu( &
Al Distributed Geodatabase »
Gu | Efl Copy
GU_ E Paste
GU_ Té Paste Special
GU_
GU_| /" Rename
GU_ e Refresh
GU_
GU_: View Metadata
GUl /'  Edit Metadata
IES| BPFeatl
_ & EIE' Properties

4 [51 Databases

% Lafayette_County.gdb i

Copying.. @

Once copied you can remove the connected folder and clean up our project Catalog tree.

4 5l Databases

El E:’L\ Lafayette_County.gdb
GU_CountyOrEquivalent

MNew 4

fal  Make Default

b g Styles
4 [ Folders Add To Favorites
b g Lafayette_County Add To New Projects
; caL e Refresh
“ | NED *  Remove I:

- GOVTUNIT_Mississippi_Stz
b B GOVTUNIT_Mississippi

SR
b BE GOVTUNIT Mississippil © o
GOVTUNIT_Mississippi View Metadata
/" Edit Metadata

P % Locators

Copyright © 2021 University of Mississippi
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Exercise 2 (Create a water mask using a threshold classification)

You can run Exercise 2 or 3 next but you must complete BOTH. You can subset the Landsat 8 scene OR
you can first perform threshold analysis to create the water mask. There are many ways to create a subset.
The quickest method is to use the Image Analysis Tool and follow Chapter 15 of the textbook. Subset using
a polygon representing Lafayette County Mississippi.

To create a water mask, you will make a simple band threshold using the near-infrared spectral band of

Landsat 8. This is a less complex method than others masked and only required the NIR band.
Open the Raster Calculator. Be sure to activate the Spatial Analysis Extension from the Customize menu.

Access the ArcTOOLBOX and use the Raster Calculator.

In the Catalog View, extend the MTL.txt file and drag the Multispectral band combination to the Map View

of your Project. When asked, calculate the statistics of the files. This may take a while.

Copyright © 2021 University of Mississippi 9
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4 LC08_L1TP_022036_20211122_20211130_02_T1
v BB LC08_L1TP_022036_20211122_20211130_02_T1_B1.TIF
v BB LC08_L1TP_022036_20211122_20211130_02_T1_B2.TIF
v EH LC08_L1TP_022036_20211122_20211130_02_T1_B3.TIF
v B8 LC08 L1TP_022036_20211122_20211130_02_T1_B4.TIF
v BB LC08_L1TP_022036_20211122_20211130_02_T1_B5.TIF
v BB LC08_L1TP_022036_20211122_20211130_02_T1_B6.TIF
v EH LC08_L1TP_022036_20211122_20211130_02_T1_B7.TIF
v B8 LCO8 L1TP_022036_20211122_20211130_02_T1_B8.TIF
v BB LC08_L1TP_022036_20211122_20211130_02_T1_BO.TIF
v BB LC08_L1TP_022036_20211122_20211130_02_T1_B10.TIF
v EH LC08_L1TP_022036_20211122_20211130_02_T1_B11.TIF
[ LCo8 L1TP_022036_20211122_20211130_02_T1_MTL json
4 BB LCO8_L1TP_022036_20211122_20211130_02_T1_MTLtxt
v B Cirrus
v B Cloud

Landcover

Multispectral

v B Pansharpen
v B oA
b B Snowlce
b B Thermal
- B Vegetation
[ m Water
v B LC08_L1TP_022036_20211122_20211130_02_T1_QA_PIXELTIF
v B LC08_L1TP_022036_20211122_20211130_02_T1_QA_RADSAT.TIF
v B LC08_L1TP_022036_20211122_20211130_02_T1_SAA.TIF
D LCO8_L1TP_022036_20211122_20211130_02_T1_stac.json
v B8 LC08 L1TP_022036_20211122_20211130_02_T1_SZATIF

Copyright © 2021 University of Mississippi
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Raster Layer Lafayette_County - Map - ArcGIS Pro

Appearance Data
7 // % DR =" F. Masklng‘ — | L - N
ms : it AN S L »- 1 L[ o
' Symbology Stretch Resampling Band 8, 5 ST R = Mor
= Type~ Type~ | Combination = Y —i | -
REAOENOES| @ Natural Color | 1]
" This renditicn is the closest to what is seen by the human eye. |

Color Infrared
Distinguishes between vegetation, urban, and water. Shows
more contrast in vegetation than Land Use.

Landuse
< Distinguishes between urban, vegetation and water. Shows
more contrast in urban land use than Color Infrared,

Land/Water Interface
Creates a clear delineation between land and water and can
account for some haze

Vegetation Analysis
. Highlights vegetation based on its water content and cell
structure,

=]
<t , Shallow Bathymetric
5 s Highlights sub-surface features in clear water,

Custom

—
X R T e e TR N N T =

Select the multispectral imagery and in the top menu ribbon select the Raster Layer>Appearance tab. Next
select the Band Combination drop down and chose the Vegetation Analysis symbology. This is a preset for
red-green-blue (RGB) display to be using the data from spectral band representing shortwave-infrared

(SWIR), near infrared, and red, respectively. For Landsat 8 OLI sensor, this is band 6, 5, and 4, respectively.

Barnids Wavelength Resolution
(micrometers) (meters)
Landsat 8 Band 1 - Coastal aerosol 043-045 30
Operational Band 2 - Blue 0.45 - 0.51 30
Land Imager Band 3 - Green 0.53-0.59 30
(OLI) Band 4 - Red 0.64 - 0.67 30
Thz':;al Band 5 - Near Infrared (NIR) 0.85 - 0.88 30
Inifearad Band 6 - SWIR 1 1.57-1.65 30
Sensor Band 7 - SWIR 2 211-2.29 30
(TIRS) Band 8 - Panchromatic 0.50-0.68 15
Band 9 - Cirrus 1.36 - 1.38 30
Launched Band 10 - Thermal Infrared
I:etH1JGFY'11, 2013 (TH?ES)1 10.60 -11.19 100
Band 11 - Thermal Infrared
(TIRS) 2 11.50 - 12.51 100

Select the multispectral imagery and in the top menu ribbon select the Raster Layer>Data tab. Next select

the Spectral Profile tool in the Create Chart drop down.

Copyright © 2021 University of Mississippi 11
All Rights Reserved.



Raster Layer

Imagery Share Appearance | Data |

Bar Chart

Histogram
Scatter Plot
Spectral Profile

BRI E |

Temporal Profile

Zoom into an area of the imagery containing water. Select the point to define an area of interest and begin
identifying locations that depict water. Select locations in large lakes and small. Next change the area of

interest color to green and select a field or somewhere with significant vegetation.

Chart Properties - Multispectral_LCO8_L1TP_022036_2021... = * X
@6: Example of Spectral Profile

Data Axes Format General @

Define an area of interest

o [N ODMO&|EE- -]
Spectral Profiles

Qltr y|x

Enabled Symbel  Label
Profile_4
Profile_5
Profile_6
Profile 7
Profile 8
Profile 9
Profile_13
Profile_15
Profile_16

Profile 13

08 EEEEEEEE
fEEEEEEEEERE

Profile_19

9,000

L Plot Type
— Profile 4

w300 [Mean Line %

— Profile_s
8,000
— Profile_6

7,500 — Profile_7

7000 —Profile 8

Scaled Radiance

— Profile_9
6,500

— Profile_13
6,000 e — Profile_15

5,500 — Profile_16

— Profile_19
5,000

500 700 900 1,000 3,000

Wavelength (nm) Catalog | Chart Properties

Note the dramatic difference in DN values between the vegetation and water pixels at approximately 850

nm.

Select the imagery layer and right-mouse button to access the context window. From there select

Properties and then select Source. Scroll to the Band Metadata to look at each of the eight (8) reflective

Copyright © 2021 University of Mississippi 12
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bands on the Landsat 8 OLI sensor. Click the NearInfrared (NIR) band to see that its wavelength in
approximately 850 nm. This is the same band you saw in the spectral profile with the large difference

between the water and vegetation signatures.

Layer Properties: Multispectral_LC08_L1TP_022036_20211122_20211130_02_T1_MTL X

General [,

Metadata + Band Metadata

Source > CoastalAerosol

Elevation 3 Blue

Display ¥ Green

Cache 3 Red

Joins + Nearlnfrared

Relates Minimum Wavelength [nm) 850,00
Maximum Wavelength (nm) 880.00
Reflectance Gain 0.000020
Radiance Gain 0.006268
Reflectance Bias -0.100000

Radiance Bias (Watts per square meter per micron) -31.3418%0

Source Band Index 1

¥ Shortwavelnfrared_1
> ShortWavelnfrared_2

* Cirrus

» Statistics

OK | | Cancel

This difference makes sense as the NIR wavelength of light is absorbed by water (i.e. not reflected) and is
highly reflected from vegetation due primarily from chlorophyll-alpha. You can use this different to create
threshold mask for water.

This method is not without uncertainty. Take for example shallow water bodies where the bottom
sediment has a spectral return that is different from deeper water. Smaller ponds that have vegetation
flowing in it; turbid water; swamps with mixed vegetation and water signatures; or edges of water bodies

with overhanging trees all create uncertainty when using the threshold method.

Copyright © 2021 University of Mississippi 13
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_ _ _ _ ~ | Chart Properties - Multispectral LCO8_L1TP_022036_2021... = * X

L,/\Y/_} Example of Spectral Profile

Data Axes Format General @

| Definean area of interest

e | ~|ODOH S| E- [ e
Spectral Profiles
Q+ &%
o T ey "5 Enabled symbol  Label
e o_ e 1 F= 3 f" - H W roies
- ~ —
. W eonies
W eronics
[ ] Prafile 7
i Profile_8
B ronies
| off Selected Features: 1 | [ | &
B e s
z o ~
[2¢ Multispectral LC08 L. pectral Profile B s
Iy -~ | Filter: = =
[EProperties |[1s Export ilter. - 2 = | BN
W e
B erotie1s
9,000
Profile_4 Plot Type
8,500 Profile_5 |MEHH Line -]
@ 8000 Profile_g
=
2 7500 Profile_7
= Profile_8
7,000
E Profile_9
S 6,500 Profile_13
%
000 Profile_15
Profile_16
5,500
— Profile_18
5,000 Profile_19
500 700 500 1,000 3,000
Wavelength (nm) Catalog | Chart Properties

In the above screenshot, look at the spectral curves from the red, green, and black. The black location is
shallow water and will be difficult to threshold using the shallower water pixel as a guide.

Zooming into the spectral profile you can see the average value of water for the 850 nm band is
approximately between 5,400 and 5,800 units. This helps identify the threshold to use for the water mask.

If we select only the pixels that have this range of values, most should represent water.

Copyright © 2021 University of Mississippi 14
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You are now ready to create a threshold raster from the Landsat imagery. Select the imagery in the
Table of Contents then the Analysis tab. Select the Raster Functions dropdown and then Raster
Functions.

Insert Analysi

= |
B Z
Ready To Tools Buffer
Use Tools -

1g ]

Geoprocessing

(_—_,' raster calculator x - |

Raster Calculator [mzgs Anzys Took
Builds and executes a single Map Algebra expression using Python syntax.

-

Using the Conditional Statement (CON) in the Raster Calculator function of ArcGIS Pro, create a function
that will create a new raster whose pixel values are a water mask. The most common nomenclature is

value 1 = water; 0 = non-water. Example:

Con("name_of file_containing_NIR_data" < selected_thershold_value, 1, 0)

Since the imagery you are using contains integer values, the selected_thershold_value will be an integer.

The general syntax of the conditional statement is as follows:

CON(Boolean function, if true, if false)

If no value or expression is given for the “false” expression then a “NoData” is assignment, which might

be more helpful to your analysis and workflow.

Because you have loaded a MTL.txt file in the viewer, the raster calculator does not display the separate

bands. You will need to load the Landsat OLI band 5 (NIR) separately.

Copyright © 2021 University of Mississippi 15
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Geoprocessing
® Raster Calculator
Parameters Environments

€3 Map Algebra expression

Rasters To [
Multispectral LC08_L1TP_022036_20211122_20211130_02_T1_MTL Coenditional H
Con
Pick I
SetNull
Math
-
con(,) i
-
s
Map Algebra expression x
® @|@ » Project » Folders » C2L1 » LCOA_LITP_022036_20211122_20211130_02_T1 » - |C)| \ la\ Search LC08_L1TP_022036_20211122_20211130.02_T1 »
Organize > New ltem = il
4 [ Project s MName Type Date Path
b g Maps [ LC08_L1TP_022036_20211122_20211130_02_T1_B1.TIF Raster Dataset 12/10/2021 9:51:20 Ph C\data\imagery\M...
b i@ Toolboxes [ LC0B_L1TP_022036_20211122_20211130_02_T1_B2TIF Raster Dataset 12/10/2021 9:51:26 Ph CAdatatimagery\M...
b f5l Databases [ LC08_L1TP 022036 20211122 2021113002 T1_B3TIF Raster Dataset 12/10/2021 3:51:28 PR CA\data\imagery\M...
b @ Styles [ LC08_L1TP_022036_20211122_20211130_02_T1_B4TIF Raster Dataset 12/10/2021 9:51:30 Ph C\data\imagery\M...
v| + Folders | |E LCO8_L1TP_022036_20211122_20211130_02_T1_B5.TIF Raster Dataset 12/10/2021 9:51:32 P C\data\imagery\M...
b B Locators [ LC0B_L1TP_022036_20211122_20211130_02_T1_B6.TIF Raster Dataset 12/10/2021 9:51:35 PR CAdatatimagery\M...
4 @ Portal [ LC08_L1TP 022036 20211122 2021113002 T1_B7.TIF Raster Dataset 12/10/2021 @51:37 Pl C\data\imagery\M...
v @ My Content {8 1.C08_L1TP_022036_20211122_20211130_02_T1_BSTIF Raster Dataset 12/10/2021 9:51:42 Ph - C:\data\imagery\M...
b My Favorites 8 1C08_L1TP_022036_20211122_20211130_02_T1_BOTIF Raster Dataset 12/10/2021 9:51:49 Ph - CAdata\imagery\M...
@
b g8 My Groups B LC08_L1TP_022036_20211122_20211130_02_T1_B10.TIF Raster Dataset 12/10/2021 9:51:22 Ph - Cadatatimagen\M...
bl i
i My Organization BB LC08_L1TP_022036 20211122 20211130,02_T1_811.TIF Raster Dataset  12/10/2021 @:51:24 PR Cédiata\imagery\M...
b i
AreGlS Cnline 188 LC08_L1TP_022036_20211122_20211130_02_T1_MTLtdt Raster Product 12/10/2021 9:51:50 P C\data\imagery\M...
3 Living Atl
B Lovng Ates [ LC08_L1TP_022036_20211122_20211130_02_T1_QA_PIXELTIF Raster Dataset 12/10/2021 9:51:50 P C\data\imagery\M...
4 Computer
E:I - _p [ LC0B_L1TP_022036_20211122_20211130_02_T1_OA_RADSAT.TIF Raster Dataset 12/10/2021 @51:50 PR CA\datatimagery\M...
Geoprocessing > X
®© Raster Calculator P
Parameters Environments @
Map Algebra expression
Rasters Tools
Y
water_thresehold_6000 *
Multispectral_LC03_L1TP_022036_20211122_20211130_02_T1_MTL / I
FE LC08_L1TP_022036_20211122_20211130.02_T1_B5.TIF —=
-
<
Con("LCBB_L1TP_©22036_28211122_20211138_@2_T1_BS.TIF" < &0e8 ,1,8)

i Output raster

| ciUsersilance yarbrough\documents\ArcGlS\lafayette water\lafayette_county\lafayette_county.gdb\water_thresehold_6000

@ ||

For this example and the scene chosen, a NIR value of 6,000 appears to be the threshold of water

reflection of the pixels.
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You will need to explore the data to determine the appropriate threshold value for the water mask. Run
the function using several different values and same the results as individual rasters. Be sure to employ a
useful naming convention as there may be many due to trial and error. For this example, the file name
has “6000” to indicate we have used that value as the threshold. Select the threshold image mask and in

the tool ribbon, select Raster Layer>Appearance and select “flicker” to compare the masks to the imagery.

Some questions you should think about as you review your results:
o Note how each mask covers the water in the scene. Are areas not water covered by a mask?

e How much error are you willing to tolerate?

In the example, several water bodies were not included in the first interaction. Parts are Sardis Lake
require a greater threshold than 6000 to capture the water. This is likely due to turbidity. Using the
Spectral Profile tool, add additional locations in the areas of water that were NOT included in the mask
for the first iteration. It appears maybe a value of 7000 will include more water pixels. Rerun the Raster
Calculator Conditional statement using a new threshold value.

Note there are many obvious water pixels there were not included in the mask. Again, how much error
are you willing to tolerate? How much time are you will devote to finding the optimum threshold value?
What is your measure of “optimum” when you know you have reached it? Does this method work for all
images? Does this method work for only certain types of the water bodies? Does this method work for
only certain parts of water bodies?

ff-w 2
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Now that you have a water mask for the entire Landsat scene, it is time to create a permanent raster in
your project database.

o Symbology -
i5 Disable Pop-ups :
b Configure Pop-ups
Data - Add to Mosaic Dataset
- B Export Rast
Sharing P | m EPO =l

Wiew Metadata

Bring up of the Context window of the water mask and Export the raster.

Export Raster 7 Rx

water_threshold_7000

General Settings

&
Output Raster Dataset
|C:\Users\Lance‘r’arbrough\Documents\ﬁrcGIS\Iafayette_water\Lafayette_County\m| 5
Coordinate System
[ WGS_1984.UTM Zone_16N - @
Geographic Transformations
|N0ne ‘|
Clipping Geometry )
| lafayette_boundary '|
Use input features for clipping geometry
Clipping Type
|Outside "|
Extent
Top
3827106.086719
Left Right
249046.160536 293974141492
Bottom
3782289.03359
[] Maintain Clipping Extent €
Cell Size
X [30 | v |30 |
Raster Size
Columns | 1439 | Rows 1435 |
Pixel Type
|2 Bit Unsigned |
MoData value
d <
+ Renderer Settings :
Copyright © 2021 University of Mississippi 18
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Be sure to use the Clipping Geometry of the county boundary and select the Use input feature for

clipping geometry option.

Copyright © 2021 University of Mississippi
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In the feature class, GU_CountyOrEquivalent, select the polygon that represents Lafayette County.

Edit Imagery Share

EIE = BE Add Preset -

Labeling Data

F@ E2 Attributes i ﬁ% ﬁ‘ ?‘EE

@ 8 Add Graphics Lgyer [d Clear ) )

Basernap Add Select Selegf By Select By Measure Locate Infographics Coordi

= Data~= =  Attrhutes Location = = = Conver
Layer Selection [P} Inquiry

« 1 x| |[E]lMap X

_
o | Ry AT ~

) - B

Pop-up > Ox |
4 GU_CountyOrEquivalent (1) m : . N
[Mississippi | &?
= GU_CountyOrEquivalent - Mississippi
A
2| |OBJECTID 52 ——
Permanent_ldentifier 1b20aa7e-36ef-420d-a07c-25376247 820904
Source_Featurs|D 28071
Source_DatasetlD fa2682ca-Thab-4d47-a8ef-0cd9a0d 1614
Source_DataDesc 2020 TIGER/Line Shapefile, Current County 1
and Equivalent /J
|
Source_Originator |5, Census Bureau |
I e
Data_Security Unclassified - |
Diictribuitinn Dalic | Duhlic Damain - Eraa DNictribogion te Thid | Y |
10f1 89.4249193°W 34.3567578°N o= 0= Q .
I I =

Next select the Multispectral image in the Table of Contents. In the Raster Layer ribbon, select Clip.

Data ¥ [, Export Features
Sharing r E Export Table
View Metadata 72 Rematch Addresses
A Edit Metadata [+ Set Data Source
[ Properties
Copyright © 2021 University of Mississippi 20
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Export Features ? X
Parameters Environments @

Input Features

GU_CountyOrEquivalent M 7T
Qutput Location

Lafayette_County.gdb

Qutput Name
lafayette_boundary

Expression

There is no expression defined.

+ New expression ~

> Fields

> Geodatabase Settings

Save the selected polygon in the Lafayette_County.gdb geodatabase. Now to crop the imagery, select the

imagery in the Table of Contents then the Analysis tab. Select the Tools Toolbox.

Insert Analysis View
,'d””':-. — 5
= . (2
Ready To  Tools Buffer
Use Tools -

10 r

In the Geoprocessing search tool, use the search window with search terms “clip raster”/

Ge
"(;:' | clip raster )
Clip Raster (Datz Management Tools

Cuts out a portion of a raster dataset, mosaic dataset, or ifhage service layer.

N\ BE

Select the Clip Raster tool in the results.

Copyright © 2021 University of Mississippi 21
All Rights Reserved.



N

Raster  Function
Functions= Editor

Raster Functions

X \Use raster functions for processing and analysis,

S) History

fx Show the history of raster functions used, The history is
saved with the project.

Raster Functions

| Find Raster Functions

Project System Custom
Wind
Chill

*» Appearance

b

Classification

b

Conversion
* Correction

¥ Data Management

= @ B &N

Aggregate Aggregate Attribute Boundary

Multidimen... Table Clean

g 2 RO

r—J € N

Clip Compaosite Constant Expand
Bands

N

H %

Interpolate Key Mask Merge

Irregular Data Metadata Rasters

Copyright © 2021 University of Mississippi
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Raster Functions ?7 0 x
® Clip Properties

General Parameters

Raster
water_threshold_7000
Clipping Type
Outside
Clipping Geometry / Raster
lafayette_boundary
[] Use input features for clipping geometry
Output Bxtent
Top
3456°
Left Right

-89.72 ¢

=1
r=)

e
fu
L

Bottom
34.16"

Save the output in the project geodatabase as L8 2021112 subset_nir. Click Run.

Exercise 2 (Create a water mask using a threshold classification)

(Subset using a vector)

You can run Exercise 2 or 3 next but you must complete BOTH. You can subset the Landsat 8 scene OR
you can first perform threshold analysis to create the water mask. There are many ways to create a subset.
The quickest method is to use the Image Analysis Tool and follow Chapter 15 of the textbook. Subset using

a polygon representing Lafayette County Mississippi.
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Exercise 4

After you have selected the appropriate water mask and its has been clipped to the Lafayette County
boundary, make a final calculation of total land area and water covered area. This information can be
found in the attribute table of the selected water mask raster file. The numbers are the total pixels (cells)

in the layer assigned with each value. Select Attribute Table and click Calculate.

Calculate Field

his tool modifies the input data.

Input Table

water_threshold_7000.tif -
Field Name (Existing or New)

Area -
Expression Type

Arcade -

Expression
Fields _ Helpers T
oD Array()
Value
Count
Attachments()
Average()
Back()
Insert Values Y A
Area =
$feature. * 090

Enable Undo

Using the Arcade expression type, create a new field call “Area” by multiplying the number of pixels in the
mask by the size of the pixels. These are Landsat 8 OLI pixels, so they are 30 m by 30 m or 900 m?. You can

also review the properties to discover the pixel size.

Deliverables:

For the laboratory report, provide screen captures of the water mask over the imagery. Create
transparencies of the mask so that the imagery can be seen below. The complete water mask of the county
(only within the county) must be displayed in a map and included in the appendix of your laboratory
report. Report the total area covered by water and non-water and compare to published values. Provide

reference(s) of published land cover data you compared. Comment on the accuracy of your chosen water
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mask and provide possible methods of reducing error. Create a single PDF of the short report and submit

via BlackBoard.

Your report must include the following:
e A cover page or transmittal memorandum
e Report must include sections of a typical report:
o Introduction, data, method, analysis, summary/discussion, appendix

Screen shot(s) showing exemplars of issues and highlights you have identi
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